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More on MS Word 2010

In earlier classes you learnt some features of MS Word 2010. In this chapter, you will learn 
some more features – spelling and grammar, thesaurus and mail merge.

SPELLING AND GRAMMAR

The spelling and grammar feature of MS Word marks your errors in spellings and grammar of 
the selected language while typing.

Before you learn how this feature works, you need to understand two basic things – how to 
set language and what are the types of errors marked by MS Word.

Setting Language

To set language means to tell MS Word that the words and grammar are to be checked according 
to a dictionary of the language you are referring to. To set language in MS word, follow the 
steps.

Step 1 	:	Click on the Review tab.

Step 2 	:	Click on Language to open the Language drop-down list.

Step 3 	:	Click on Set Proofing Language to open the Language 
dialog box.

Step 4 	:	Click and select English (U.S.). By default, MS Word 
uses English (U.S.).

Step 5 	:	Click on OK.

Types of Errors Marked by MS Word

MS Word underlines the different types of errors in different 
colors. 

•	 The red wavy line shows spelling errors. The correct spelling 
is ‘kitchen’.

•	 The green wavy line shows a grammatical mistake. In this example, ‘were’ should be used 
instead of ‘was’.

Steps to set the language

In this chapter, you will learn about :
• Spelling and grammar		  • Thesaurus 		

• Mail Merge
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•	 The blue wavy line shows words are correct in spelling but not meaningful in the sentences. 
It is called a contextual error. In this example, ‘floor’ should be used instead of ‘flour’.

Checking Spelling and Grammar

Let us now learn how to check spelling and grammar in a document. It can be done in two 
ways. You can allow MS Word to mark errors automatically when you type or you can run a 
spelling and grammar check after completing the typing of the text.

Automatic spelling and grammar checking 
By default, MS Word automatically checks a document for spelling and grammar errors. Therefore, 
you may not need to run a separate spelling and grammar check. These errors are highlighted 
by colored wavy lines as discussed earlier. However, if the automatic spelling and grammar 
checking settings have been turned off, follow the steps to allow MS Word to automatically 
mark spelling and grammar errors.

Step 1	 :	Click on the File tab.

Step 2	 :	Click on Options to open the Word Options dialog box.

Step 3	 :	Click on the Proofing tab.

Step 4	 :	Checking the Check Spelling as you type option will make spelling 
errors automatically while you type.

Step 5	 :	Checking the Use contexual spelling option will mark the contexual 
errors.

Step 6 	:	Checking the Check grammar with spelling option will mark both 
spelling and grammatical errors automatically.

Step 7 	:	Checking the Mark grammar 
errors as you type option 
will automatically mark the 
grammatical errors when 
you type.

Step 8 	:	Click on OK.

Steps to activate the automatic error checking
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Correcting errors 
To correct the errors, right-click on the marked word to look for various options available and 
select the correct one. The suggestions displayed in the pop-up menu on the right-click of 
the errors indicated. Click on the correct spelling or phrase. The corrected word or phrase will 
appear in the document. If no change in spellings is required, click on Ignore. If no grammar 
errors is required, click on Ignore once.

There were many  utensils lying 
on the floor of the kitchen.

(a) Grammar 
suggestion

(b) Contextual 
suggestion

(c) Spelling 
suggestion (d) Corrected suggestion

Running a spelling and grammar check 
To check spelling and grammar after completing the text, follow the steps .

Step 1 	:	Click on the Review tab.

Step 2 	:	In the Proofing group, click on Spelling 
& Grammar to open the Spelling and 
Grammar dialog box.

Step 3 	:	The errors will be marked in colors as 
explained earlier.

Step 4 	:	The suggestions to correct errors are 
listed.

Step 5 	:	Choose a suggestion and click on Change 
to correct the errors.

Step 6 	:	Click on Ignore Once to skip the word 
without changing it.

Steps to check spelling and grammar 
after completing text
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Step 7 	:	Click on Ignore All to skip the word without changing it 
and also to skip all other instances of this word in the 
document.

When all errors have been considered, MS Word will display a 
dialog box to inform that the spelling and grammar check has been 
completed. Click on OK to continue.

Adding New Words to the MS Word Dictionaries

Generally, proper nouns like your name are not present in MS 
Word’s dictionary. So MS Word will mark your name as a spelling 
error in the document. To avoid this problem, you can add your name 
to the dictonary. To do so, click on the Add to Dictionary (
)button in the Spelling and Grammar dialog box. This will add the 
word to the dictionary and will not be marked as a spelling error 
on that computer only.

You can also add such a word by right-clicking on it and selecting 
the Add to Dictionary option from the list.

THESAURUS

You all are familiar with synonyms and antonyms. Synonyms are different words having the 
same meaning. Antonyms are the word with the opposite meaning.

Do you know a simple word like ‘good’ has many synonyms such as decent, helpful, safe, useful, 
well-mannered, polite, obedient and first-class? The antonyms of ‘good’ are bad, naughty etc. 
It is difficult to remember all the synonyms and antonyms of a word.

The thesaurus feature gives a list of all the synonyms and antonyms of a selected word. To use 
the thesaurus feature of MS Word, follow the steps.

Step 1 	:	Select a word, for example, good.

Step 2 	:	Click on the Review tab.

Step 3 	:	Click on Thesaurus. This will open the research task pane on the right side of the MS 
Word window.

Spelling and grammar 
check complete

Add to Dictionary option

Nitu and Sachin are good children.

Step 4 	:	This list shows 
the synonyms and 
antonyms of the 
word 'good'.
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MAIL MERGE 

Suppose you want to send a letter or an invitation to many people. It will take a lot of time 
and efforts if the same letter is prepared separately for everyone. Mail merge is a feature in 
MS Word that is used to create multiple personalized letters. It saves a lot of time, as you do 
not need to change the information for the new recipient again and again. The steps involved 
in creating a mail merge.

Step 1 :	 	Type an invitation which is to be sent to many people. 
You have to type only those common details which 
are to be sent to everyone.

Step 2 	:	 Click on the Mailings tab.

Step 5 	:	Hover your mouse on the word you want to select.

Step 6 	:	Click on this arrow to open a drop-down list.

Step 7 	:	Click Insert to replace the old word with the new word.

The new word (synonym or antonym) will replace the old word without 
changing any other word in the document. 

Steps to use the thesaurus 
feature of MS Word

Use of the thesaurus 
feature

(a) Original text

(c) Use of antonym

(a) Use of synonym

The history of MS Office starts officially from November, 1990 when Office for Windows 
(also known as MS Office 1.0) was released for use with Windows 2.0. It had a combination 
of Word 1.1, Excel 2.0 and PowerPoint 2.0. Before MS Office 1.0, the basic elements of the 
package were still available as separate programs, but for MS-DOS. The main input device 
for pre Windows MS Word was the keyboard. Mouse was a luxury, not used by many.

Know 
More

Step 3 	:	 Click on Start Mail Merge to open the drop-
down list.

Step 4 	:	 Click on the Step by Step Mail Merge Wizard 
option to open the Mail Merge task pane on 
the right.
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Step 5 	:	 Click on the Letters option 
(if not selected by default).

Step 6 	:	 Click on Next: Starting 
document to move to step 2 
of the Wizard.

Step 7 	:	 Click on Use the current 
document (if not selected 
by default).

Step 8 	:	 Click no Next: Select recipients to move to step 3 of the 
Wizard.

Step 9	 :	 Select the Type a new list option.

Step 10	:	 Click on Create to open the New Address List dialog 
box.

Step 11	:	 Add Title like Mr., Mrs., Ms., Dr., etc. and press the Tab 
key to move to the next field.

New Address List 
dialog box

Step 12	:	 Similarly, enter First Name, 
Last Name, Address Line 1, 
Address Line 2, City, etc. After 
completing the details of one 
recipient, press the Tab key in 
the last filed to create a new 
row for next recipient’s details.

Filled-in New Address List dialog box

Step 13	:	After entering the details of recipients, 
click on OK to open the Save Address 
List dialog box.

Step 14	:	 Enter ‘Recipients’ as the file name.

New Address List dialog box



31 Computer-6

Step 15	:	 Click on Save to open 
the Mail Merge Recipients 
dialog box.

Save Address List dialog box

Step 16	:	 Click on OK

Step 17	:	 Click on the Next: Write 
Your Letter option to 
move to step 4 of the 
Wizard.

Step 18	:	 Click on the More 
items option to open 
the Insert Merge Field 
dialog box.

Step 19	:	 Click on Title 
(if not selected 
by default.)
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Step 20 :	 Click on Insert to add  Title  field below ‘To’ in 
the invitation letter. Similarly, add First Name and Last 
Name, etc. Click on Close when you want to start from 
a new line and again click on the More items option. 
Move the insertion pointer after Dear and insert the 
First Name field. Your invitation letter will now look 
similar. Click on the Next: Preview your letters option 
to move to step 5 of the Wizard.

(a)

(b)

(d)

(a)

(c)

Completion of Mail Merge

Step 21	: 	Click  or  to see the letters addressed 
to different recipients. Samples of invitation 
letters created using Mail Merge.

Step 22 	:	 Click on the Next: Complete the merge option 
to move to step 6 of the wizard.

Step 23 	:	 Click on the Print option to print separate 
letters for all the recipients.
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Points to Remember
•	 The spelling and grammar feature in MS Word marks the errors in spellings and grammar while 

typing.

•	 The red and green wavy lines show spelling and grammatical errors, respectively.

•	 The blue wavy lines shows words which are correct in spelling but not meaningful in the 
sentence.

•	 To correct spelling and grammar errors, right-click the underlined word or phrase and choose 
the correct spelling or phrase from the listed suggestions.

•	 To add a word to the dictionary right-click on the word and select the Add to Dictionary 
option.

•	 The thesaurus feature gives a list of synonyms and antonyms of a selected word.

•	 The mail merge feature is used to create a personalized letter for many people without 
preparing it separately for everyone.

•	 To create a mail merge, you need to select the step by step Mail Merge Wizard and follow the 
six main steps to complete it.

A.	 Tick () the correct option :

	 1.	 Which wavy line shows grammatical mistake?

	 (a)	 Red	 	 (b)	 Green	 	 (c)	 Blue	

	 2. 	The spelling and grammar command is available under the  

	 (a)	 Review tab	 	 (b)	 Reference tab	 	 (c)	 Home tab	

	 3.	 Which feature is used to view antonyms and synonyms of a word?

	 (a)	 Spelling Grammar	 	 (b)	 Thesaurus	 	 (c)	 Mailings	

	 4. 	Under which tab is the mail merge option found? 

	 (a)	 Home	 	 (b)	 Mailings	 	 (c)	 Insert	

	 5.	 Which wavy line shows spelling errors :

	 (a)	 Blue	 	 (b)	 Green	 	 (c)	 Red	

B.	 Fill in the blanks :
	 1.	 The _______________ line indicates a contextual error.
	 2.	 The thesaurus feature is present under the _______________ tab.
	 3.	 The start Mail Merge command is found under the _______________ tab.
	 4.	 Press the _______________ key to check spelling and grammar.
	 5.	 There are _______________ main steps to complete a mail merge.
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C.	 Match the columns given below :
	 1.	 synonym	 (a) 	 Personalized letters

	 2.	 F7	 (b)	 opposite meaning

	 3.	 Mail Merge	 (c) 	 Thesaurus

	 4.	 Red wavy line	 (d) 	 Spelling errors	  

	 5.	 Antonym 	 (e)	 Spelling and grammar	

D.	 Tick () the correct statements and cross () the incorrect ones :

	 1.	 By default, MS Word automatically checks a document for spelling and grammar errors.	

	 2.	 The red line indicates a contextual error.	

	 3.	 Synonyms are different words having the same meaning.	

	 4.	 Antonyms are the words with the opposite meaning.	

	 5.	 Mail Merge is a not a feature of MS Word.	

E.	 Answer the following Questions :
	 1.	 What are the three basic types of spelling and grammar errors in MS Word?
	 2.	 How can you correct spelling and grammar errors in MS Word?
	 3.	 What is the use of the thesaurus feature of MS Word?
	 4.	 What is the advantage of using Mail Merge?
	 5.	 What does the spelling and grammar feature of MS-Word?
	 6.	 What are the suggestions shown in the document, when spelling and grammar check feature 

work on the document?
	 7.	 Is it possible to add a new word to the MS Word dictionary?
	 8.	 What is the meaning of blue wavy line?

ACTIVITY

	 •	 Using Mail Merge, prepare letters to be sent to the parents of all the students to invite 
them for the annual day celebration of your school.


